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F-02 (ANSYS) 

Формулировка задачи: 

Дано: ʂʦʥʩʦʣʴʥʳʡ ʩʪʝʨʞʝʥʴ ʧʦʩʪʦʷʥʥʦʡ 

ʞʸʩʪʢʦʩʪʠ ʥʘʛʨʫʞʝʥ ʠʟʛʠʙʘʶʱʠʤ 

ʤʦʤʝʥʪʦʤ M ʚ ʪʦʯʢʝ A. 

E ï ʤʦʜʫʣʴ ʫʧʨʫʛʦʩʪʠ ʤʘʪʝʨʠʘʣʘ; 

I Z ï ʠʟʛʠʙʥʳʡ ʤʦʤʝʥʪ ʠʥʝʨʮʠʠ. 

Построить: Эʧʶʨʫ ʚʥʫʪʨʝʥʥʝʡ ʧʝʨʝʨʝʟʳʚʘʶʱʝʡ ʩʠʣr QY;  

ʕʧʶʨʫ ʚʥʫʪʨʝʥʥʝʛʦ ʠʟʛʠʙʘʶʱʝʛʦ ʤʦʤʝʥʪʘ MZ. 

ɸʥʘʣʠʪʠʯʝʩʢʠʡ ʨʘʩʯʸʪ (ʩʤ. F-02) ʜʘʸʪ ʩʣʝʜʫʶʱʠʝ ʨʝʰʝʥʠʷ: 
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Рис. 1. 

ɿʘʜʘʯʘ ʜʘʥʥʦʛʦ ʧʨʠʤʝʨʘ: ʧʨʠ ʧʦʤʦʱʠ ANSYS Multyphisics ʧʦʣʫʯʠʪʴ ʵʪʠ ʞʝ 

ʵʧʶʨʳ ʤʝʪʦʜʦʤ ʢʦʥʝʯʥʳʭ ʵʣʝʤʝʥʪʦʚ. 
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Предварительные настройки: 

ɼʣʷ ʨʝʰʝʥʠʷ ʟʘʜʘʯʠ ʠʩʧʦʣʴʟʫʝʪʩʷ ANSYS Multiphysics 14.0: 

 

 

 

Utility Menu (U_M) 

Main Menu 

(M_M) 

ʈʘʙʦʯʝʝ ʧʦʣʝ 

ANSYS Command Prompt (C_P) 

ʂʥʦʧʢʘ 

Fit 

 

C ʤʝʥʶ M_M ʠ U_M ʨʘʙʦʪʘʶʪ ʤʳʰʴʶ, ʚʳʙʠʨʘʷ ʥʫʞʥʳʝ ʦʧʮʠʠ. 

ɺ ʦʢʥʦ C_P ʚʨʫʯʥʫʶ ʚʚʦʜʷʪ ʪʝʢʩʪʦʚʳʝ ʢʦʤʘʥʜʳ, ʧʦʩʣʝ ʯʝʛʦ ʩʣʝʜʫʝʪ 

ʥʘʞʘʪʴ ʥʘ ʢʣʘʚʠʘʪʫʨʝ . 

 

ʏʸʨʥʦʝ ʨʘʙʦʯʝʝ ʧʦʣʝ ʥʝ ʚʩʝʛʜʘ 

ʧʨʠʷʪʥʦ ʜʣʷ ʛʣʘʟʘ. ʂʨʦʤʝ ʪʦʛʦ, ʦʥʦ 

ʥʝʫʜʦʙʥʦ ʜʣʷ ʧʝʯʘʪʠ ʨʠʩʫʥʢʦʚ. 

ʄʝʥʷʝʤ ʯʸʨʥʳʡ ʮʚʝʪ ʬʦʥʘ ʥʘ ʙʝʣʳʡ 

ʩʣʝʜʫʶʱʠʤʠ ʜʝʡʩʪʚʠʤ̫ʠ: 

U_M > PlotCtrls  > Style  > Colors  

> Reverse  Video  

 

ʋʙʨʘʪʴ ʧʫʥʢʪʳ ʤʝʥ,ʁ ʦʪʥʦʩʷʱʠʝʩʷ ʢ 

ʨʘʩʧʣʘʚʘʤ, ʤʘʛʥʠʪʘʤ ʠ ʪʘʢ ʜʘʣʝʝ, ʦʩʪʘʚʠʪʴ ʪʦʣʴʢʦ 

ʦʪʥʦʩʷʱʠʝʩʷ ʢ ʧʨʦʯʥʦʩʪʥʳʤ ʨʘʩʯʸʪʘʤ: 

M_M > Preferences > ʆʪʤʝʪʠʪʴ ñStructural ò > OK 
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ʇʨʠ ʧʦʩʪʨʦʝʥʠʷʭ ʧʦʣʝʟʥʦ ʚʠʜʝʪʴ 

ʥʦʤʝʨʘ ʪʦʯʝʢ ʠ ʣʠʥʠʡ ʪʚʝʨʜʦʪʝʣʴʥʦʡ 

ʤʦʜʝʣʠ ʘ ʪʘʢʞʝ ʥʦʤʝʨʘ ʫʟʣʦʚ ʤʦʜʝʣʠ 

ʢʦʥʝʯʥʦʵʣʝʤʝʥʪʥʦʡ: 

U_M > PlotCtrls  > Numbering  > 

ʆʪʤʝʪʠʪʴ KP, LINE , NODE ;  

ʋʩʪʘʥʦʚʠʪʴ Elem ʥʘ ñNo number ing ò;  

ʋʩʪʘʥʦʚʠʪʴ [/ NUM] ʥʘ ñColors  & numbers ò 

> OK 

ɼʣʷ ʙʦʣʴʰʝʡ ʥʘʛʣʷʜʥʦʩʪʠ ʫʚʝʣʠʯʠʤ ʨʘʟʤʝʨ ʰʨʠʬʪʘ: 

U_M > PlotCtrls  > Font Controls  > Legend F ont  > 

ʋʩʪʘʥʦʚʠʪʴ çʈʘʟʤʝʨè ʥʘ ç22è 

> OK 

U_M > PlotCtrls  > Font  Controls  > Entity  Font  > 

ʋʩʪʘʥʦʚʠʪʴ çʈʘʟʤʝʨè ʥʘ ç22è 

> OK 

 

 

 

 

 

ʇʨʝʜʚʘʨʠʪʝʣʴʥʳʝ ʥʘʩʪʨʦʡʢʠ ʚʳʧʦʣʥʝʥʳ, ʤʦʞʥʦ ʧʨʠʩʪʫʧʘʪʴ ʢ ʨʝʰʝʥʠʶ 

ʟʘʜʘʯʠ. 
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Решение задачи: 

ʆʙʨʘʪʠʪʝ ʚʥʠʤʘʥʠʝ: ʢʦʥʝʯʥʦʵʣʝʤʝʥʪʥʳʡ ʤʝʪʦʜ ʨʝʰʝʥʠʷ ʟʘʜʘʯ численный, ʦʥ ʧʨʠʥʠʤʘʝʪ ʠ ʚʳʜʘʸʪ ʪʦʣʴʢʦ числа. ɿʘʜʘʯʘ ʞʝ 

ʩʬʦʨʤʫʣʠʨʦʚʘʥʘ в общем виде ï ʚ ʙʫʢʚʝʥʥʳʭ ʦʙʦʟʥʘʯʝʥʠʷʭ, ʠʟ ʢʦʪʦʨʳʭ ʧʦʪʦʤ ʩʢʣʘʜʳʚʘʶʪʩʷ ʬʦʨʤʫʣʳ. ɺʳʭʦʜ ʤʦʞʥʦ ʥʘʡʪʠ, 

ʧʨʠʨʘʚʥʷʚ ʙʘʟʦʚʳʝ ʚʝʣʠʯʠʥʳ ʟʘʜʘʯʠ E, I Z, M ʠ l ʢ ʝʜʠʥʠʮʝ. ʊʦʛʜʘ ʨʝʟʫʣʴʪʘʪʳ ʤʳ ʧʦʣʫʯʠʤ ʚ ʚʠʜʝ ʯʠʩʝʣ, ʦʙʦʟʥʘʯʝʥʥʳʭ ʥʘ рис. 1. 

ʩʠʥʠʤ ʮʚʝʪʦʤ.  

ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

1 

Задаём параметры расчёта – базовые величины задачи: 

U_M > Parameters > Scalar Parameters  > 

ɺ ʩʪʨʦʢʝ ñSelection ò ʧʦʩʣʝʜʦʚʘʪʝʣʴʥʦ ʥʘʙʨʘʪʴ (ʚʩʸ ʣʘʪʠʥʠʮʝʡ!): 

E=1 > Ac cept  > 

A=1e6 > Accept  > 

Iz=1 > Accept  > 

M=1 > Accept  > 

l=1 > Accept  > 

nu=0.3 > Accept  > 

A ï ʧʣʦʱʘʜʴ ʧʦʧʝʨʝʯʥʦʛʦ ʩʝʯʝʥʠʷ ʩʪʝʨʞʥʷ; ʜʦʣʞʥʘ ʙʳʪʴ ʦʯʝʥʴ ʙʦʣʴʰʦʡ ʜʣʷ ʪʦʛʦ, 

ʯʪʦʙʳ ʩʪʝʨʞʝʥʴ ʛʥʫʣʩʷ, ʥʦ ʥʝ ʩʞʠʤʘʣʩʷ ʠ ʥʝ ʨʘʩʪʷʛʠʚʘʣʩʷ; 

nu  ï ʢʦʵʬʬʠʮʠʝʥʪ ʇʫʘʩʩʦʥʘ ʜʣʷ ʤʝʪʘʣʣʦʚ. 

ʇʦʩʣʝ ʥʘʞʘʪʠʷ ʢʣʘʚʠʰʠ Accept, ʚʚʝʜʸʥʥʳʡ ʧʘʨʘʤʝʪʨ ʜʦʙʘʚʣʷʝʪʩʷ ʚ ʩʧʠʩʦʢ Items. 

ɿʘʢʨʳʪʴ ʦʢʥʦ ʚʚʦʜʘ ʧʘʨʘʤʝʪʨʦʚ: 

> Close  
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

2 

Первая строчка в таблице конечных элементов – плоский балочный тип BEAM3: 

M_M  > Preprocessor  

C_P  > ET,1, BEAM3 >  

ʇʦʩʤʦʪʨʠʤ ʪʘʙʣʠʮʫ ʢʦʥʝʯʥʳʭ ʵʣʝʤʝʥʪʦʚ:  

M_M > Preprocessor > Element Type > Add/Edit/Delete > Close  
 

3 

Первая строчка в таблице параметров («реальных констант») выбранного типа 

конечного элемента:Площадь поперечного сечения = A;момент инерции = Iz; высота 

= l/100 (не будем использовать, но формально надо что-то задать, например l/100). 

C_P > R,1,A,Iz,L/10 0 >  

ʇʦʩʤʦʪʨʠʤ ʪʘʙʣʠʮʫ ʨʝʘʣʴʥʳʭ ʢʦʥʩʪʘʥʪ:  

M_M > Preprocessor > Real  Constants  > Add/Edit/Delete  > Close   

4 

Свойства материала стержня – модуль упругости и коэффициент Пуассона: 

M_M > Preprocessor > Material Props > Material Models > 

Structural > Linear > Elastic > Isotropic > ʚ ʦʢʦʰʢʝ EX ʧʠʰʝʤ 

ñEò, ʚ ʦʢʦʰʢʝ PRXY ʧʠʰʝʤ ñnuò > OK 

ɿʘʢʨʳʚʘʝʤ ʦʢʥʦ çDeine Material Model Behaviorè. 
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

ʊʚʝʨʜʦʪʝʣʴʥʦʝ ʤʦʜʝʣʠʨʦʚʘʥʠʝ 

5 

Разворот рабочей плоскости: 

ʇʨʦʨʠʩʦʚʳʚʘʝʤ ʩʠʩʪʝʤʫ ʢʦʦʨʜʠʥʘʪ ʨʘʙʦʯʝʡ ʧʣʦʩʢʦʩʪʠ. ʉʝʡʯʘʩ ʦʥʘ 

ʦʨʠʝʥʪʠʨʦʚʘʥʘ ʧʦ ʛʣʦʙʘʣʴʥʦʡ ʩʠʩʪʝʤʝ ʢʦʦʨʜʠʥʘʪ: 

U_M > WorkPlane > Display Working Plane  

ʇʦʚʦʨʘʯʠʚʘʝʤ ʨʘʙʦʯʫʶ ʧʣʦʩʢʦʩʪʴ ʥʘ 180 ʛʨʘʜʫʩʦʚ ʚʦʢʨʫʛ ʦʩʠ 

Y ʩ ʪʝʤ, ʯʪʦʙʳ ʝʸ ʦʩʴ X ʙʳʣʘ ʥʘʧʨʘʚʣʝʥʘ ʩʧʨʘʚʘ ʥʘʣʝʚʦ: 

U_M > WorkPlane > Offset WP by Increments  > 

ʐʝʩʪʴ ʨʘʟ ʥʘʞʠʤʘʝʤ ʥʘ ʧʦʷʚʠʚʰʝʡʩʷ ʧʘʥʝʣʴʢʝ ʢʥʦʧʢʫ 

, ʥʘʙʣʶʜʘʷ, ʢʘʢ ʩʠʩʪʝʤʘ ʢʦʦʨʜʠʥʘʪ ʨʘʙʦʯʝʡ 

ʧʣʦʩʢʦʩʪʠ ʩ ʢʘʞʜʳʤ ʥʘʞʘʪʠʝʤ ʧʦʚʦʨʘʯʠʚʘʝʪʩʷ ʚʦʢʨʫʛ ʦʩʠ Y 

ʥʘ ʪʨʠʜʮʘʪʴ ʛʨʘʜʫʩʦʚ. 

 

6 

Рабочая система координат №11 (ось x направлена влево): 

U_M > WorkPlane > Local Coordinate  Systems > Create Local CS 

> At WP Origin >  

KCN ʧʠʰʝʤ 11 

KCS ʫʩʪʘʥʘʚʠʪʴ Cartesian  

> OK 

 

ɸʢʪʠʚʥʘʷ ʩʠʩʪʝʤʘ ʢʦʦʨʜʠʥʘʪ ʘʚʪʦʤʘʪʠʯʝʩʢʠ ʤʝʥʷʝʪʩʷ ʩ ʛʣʦʙʘʣʴʥʦʡ (ʜʝʢʘʨʪʦʚʘ 

ʩʠʩʪʝʤʘ ˉ0, ʦʩʴ X ʚʧʨʘʚʦ) ʥʘ ʫʩʪʘʥʦʚʣʝʥʥʫʶ ʥʘʤʠ (ʜʝʢʘʨʪʦʚʘ ˉ11, ʦʩʴ X ʚʣʝʚʦ). 

ʄʦʞʝʪʝ ʟʘʤʝʪʠʪʴ, ʢʘʢ ʚʥʠʟʫ ʥʘʜʧʠʩʴ çcsys=0è ʠʟʤʝʥʠʣʘʩʴ ʥʘ çcsys=11è. ʊʝʤ ʥʝ 

ʤʝʥʝʝ, ʦʩʠ ʛʣʦʙʘʣʴʥʦʡ ʩʠʩʪʝʤʳ ʢʦʦʨʜʠʥʘʪ ʧʨʦʜʦʣʞʘʶʪ ʦʪʦʙʨʘʞʘʪʴʩʷ. 

 

 

Ось X рабочей 

плоскости 

Ось X глобальной 

системы координат. 
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

7 

Гасим в рабочем поле оси рабочей плоскости и оси глобальной системы координат, 

прорисовываем оси локальной рабочей системы координат №11 (ось x): 

U_M > WorkPlane > Display Working Plane  

U_M > PlotCtrls  > Window Controls  > Window Options  > 

[/ Triad ] ʫʩʪʘʥʦʚʠʪʴ ñNot  Shownò 

> OK 

U_M > PlotCtrls  > Symbols  > 

[ CS]  ʫʩʪʘʥʦʚʠʪʴ ʚ ʧʦʣʦʞʝʥʠʝ ñonò 

> OK >  

 

 

 

 

 

 

ʅʘ ʨʘʙʦʯʝʤ ʧʦʣʝ ʦʩʪʘʸʪʩʷ ʨʠʩʫʥʦʢ ʦʩʝʡ ʨʘʙʦʯʝʡ ʩʠʩʪʝʤʳ ʢʝʦʦʨʜʠʥʘʪ ʠ ʝʸ ʥʦʤʝʨ 

ç11è. 

ʆʩʠ ʣʦʢʘʣʴʥʳʭ ʩʠʩʪʝʤ ʥʝ ʧʦʜʧʠʩʳʚʘʶʪʩʷ, ʪʦʣʴʢʦ ʧʦ ʮʚʝʪʫ ʤʦʞʥʦ ʦʧʨʝʜʝʣʠʪʴ ʠʭ 

ʥʘʟʚʘʥʠʷ: 

X ï ʯʸʨʥʘʷ ʦʩʴ; 

Y ï ʟʝʣʸʥʘʷ ʦʩʴ; 

Z ï ʩʠʥʷʷ ʦʩʴ. 

ʉʝʡʯʘʩ ʚ ʨʘʙʦʯʝʤ ʧʦʣʝ ʤʳ ʚʠʜʠʤ ʦʩʠ X (ʚʣʝʚʦ) ʠ Y (ʚʚʝʨʭ). ʆʩʴ Z ʥʘʧʨʘʚʣʝʥʘ ʦʪ ʥʘʩ ʠ 

ʥʝ ʚʠʜʥʘ. 
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

8 

Ключевые точки – границы участков (две точки): 

M_M > Preprocessor > M ʦdeling > Create > Keypoints > In 

Active CS >  

NPT ʧʠʰʝʤ 1 

X, Y,Z  ʧʠʰʝʤ 0, 0, 0 

> Apply  > 

NPT ʧʠʰʝʤ 2 

X, Y,Z  ʧʠʰʝʤ l,0,0  

 > OK 

ʇʨʦʨʠʩʦʚʳʚʘʝʤ ʚʩʸ, ʯʪʦ ʝʩʪʴ: U_M > Pl ot  > Multi - Plots  

ʉʧʨʘʚʘ ʦʪ ʨʘʙʦʯʝʛʦ ʧʦʣʷ ʥʘʞʠʤʘʝʤ ʢʥʦʧʢʫ Fit . 

 

9 

Один участок –  одна линия между точками: 

M_M > Preprocessor > M ʦdeling > Create > Line s > Lines  > 

Straight  Line > 

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʥʘʞʘʪʴ ʧʦʩʣʝʜʦʚʘʪʝʣʴʥʦ ʥʘ ʢʣʶʯʝʚʫʶ ʪʦʯʢʫ 

2, ʧʦʪʦʤ ʥʘ ʢʣʶʯʝʚʫʶ ʪʦʯʢʫ 1. ʃʠʥʠʷ ʜʦʣʞʥʘ ʙʳʪʴ ʧʨʦʪʷʥʫʪʘ 

ʩʣʝʚʘ ʥʘʧʨʘʚʦ, ʪʦʛʜʘ ʵʧʶʨʘ ʤʦʤʝʥʪʦʚ ʙʫʜʝʪ ʥʘʯʝʨʯʝʥʘ ʢʦʨʨʝʢʪʥʦ 

> OK 

 

10 

Заделка: 

M_M > Preprocessor  > Loads  > Define  Loads  > Apply  

> Structural  > Displacement  > On Keypoints  > 

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʥʘʞʘʪʴ ʥʘ ʢʣʶʯʝʚʫʶ ʪʦʯʢʫ 1 

> OK > 

Lab2 ʫʩʪʘʥʦʚʠʪʴ ñAll  DOFò 

> OK 
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

11 

Внешний сосредоточенный момет M: 

M_M > Preprocessor  > Loads  > Define  

Loads  > Appl y > Structural  > 

Force /Moment  > On Keypoints  > 

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʥʘʞʘʪʴ ʥʘ ʢʣʶʯʝʚʫʶ 

ʪʦʯʢʫ 2 

> OK >  

Lab  ʫʩʪʘʥʦʚʠʪʴ ñMZò 

VALUE ʫʩʪʘʥʦʚʠʪʴ ñ- Mò 

> OK 

ɺʥʝʰʥʠʡ ʤʦʤʝʥʪ ʚ ANSYS- ʝ ʦʪʦʙʨʘʞʘʝʪʩʷ ʩʚʦʠʤ ʚʝʢʪʦʨʦʤ ï 

ʜʚʫʛʣʘʚʦʡ ʩʪʨʝʣʢʦʡ. ɺʝʢʪʦʨ ʤʦʤʝʥʪʘ ʚ ʜʘʥʥʦʡ ʟʘʜʘʯʝ ʥʘʧʨʘʚʣʝʥ 

ʧʨʦʪʠʚ ʦʩʠ Z ʛʣʦʙʘʣʴʥʦʡ ʩʠʩʪʝʤʳ ʢʦʦʨʜʠʥʘʪ. ʇʦʵʪʦʤʫ ʤʦʤʝʥʪ 

ʟʘʜʘʸʤ ʦʪʨʠʮʘʪʝʣʴʥʳʡ. 

 

12 

Изометрия: 

ɼʦ ʩʠʭ ʧʦʨ ʤʦʜʝʣʠ ʤʳ ʨʘʩʩʤʘʪʨʠʚʘʣʠ, ʠʩʧʦʣʴʟʫʷ ʬʨʦʥʪʘʣʴʥʳʡ ʚʠʜ (çʩʙʦʢʫè). 

ɺʝʢʪʦʨ ʠʟʛʠʙʘʶʱʝʛʦ ʤʦʤʝʥʪʘ ʧʨʠ ʵʪʦʤ ʚʠʜʝʥ ʧʣʦʭʦ, ʘ ʝʛʦ ʥʘʧʨʘʚʣʝʥʠʝ ʥʝ 

ʦʧʨʝʜʝʣʷʝʪʩʷ ʚʦʚʩʝ. ʄʝʥʷʝʤ ʫʛʦʣ ʟʨʝʥʠʷ: ʩʧʨʘʚʘ ʦʪ ʨʘʙʦʯʝʛʦ ʧʦʣʷ ʥʘʞʠʤʘʝʤ 

ʢʥʦʧʢʠ 

 - ʠʟʦʤʝʪʨʠʷ; 

  - ʘʚʪʦʬʦʨʤʘʪ (ʨʘʟʤʝʨ ʠʟʦʙʨʘʞʝʥʠʷ ʧʦ ʨʘʟʤʝʨʫ ʦʢʥʘ ʨʘʙʦʯʝʛʦ ʧʦʣʷ). 
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ʂʦʥʝʯʥʦʵʣʝʤʝʥʪʥʘʷ ʤʦʜʝʣʴ 

13 

Указываем материал, реальные константы и тип элементов, на которые будут 

разбиты линии твердотельной модели: 

M_M > Preprocessor  > Meshing  > Mesh Attributes  > Picked  

Lines  > ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʥʘʞʘʪʴ ʥʘ ʣʠʥʠʶ L1 > OK > 

MAT ʫʩʪʘʥʦʚʠʪʴ ñ1ò 

REAL ʫʩʪʘʥʦʚʠʪʴ ñ1ò 

TYPE ʫʩʪʘʥʦʚʠʪʴ ñ1 BEAM3ò 

> OK 

 

14 

Участок без распределённых нагрузок можно бить одним конечным элементом: 

M_M > Preprocessor  > Meshing  > Size  Cntrls  > 

ManualSize > Lines  > Picked  Lines > 

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʥʘʞʘʪʴ ʥʘ ʣʠʥʠʶ L1 

> OK >  

NDIV ʧʠʰʝʤ 1 

> OK 

ʆʙʥʦʚʣʷʝʤ ʠʟʦʙʨʘʞʝʥʠʝ: 

U_M > Plot  > Multi - Plots  

 

15 

Рабиваем линию на элементы (в данном случае, один элемент): 

M_M > Preprocessor  > Meshing  > Mesh > Lines  > 

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʥʘʞʘʪʴ ʥʘ ʣʠʥʠʶ L1 

> OK >  

ʆʙʥʦʚʣʷʝʤ ʠʟʦʙʨʘʞʝʥʠʝ: 

U_M > Plot  > Elements  

 

ключевые точки 

линия 

конечный элемент 

узлы 
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Действие необязательное, но наглядное. Переносим на конечноэлементную модель 

нагрузки и закрепления с модели твердотельной: 

M_M > Loads  > Define  Loads  > Operate  > 

Transfer  to  FE > All  Solid  Lds  > OK 

 

ʈʘʩʯʸʪ 

17 

Запускаем расчёт: 

M_M > Solution  > Solve  > Current LS  

ʉʠʥʭʨʦʥʥʦ ʧʦʷʚʣʷʶʪʩʷ ʜʚʘ ʦʢʥʘ: ʙʝʣʦʝ 

ʠʥʬʦʨʤʘʮʠʦʥʥʦʝ ʠ ʩʝʨʦʝ ʠʩʧʦʣʥʠʪʝʣʴʥʦʝ. 

ɹʝʣʦʝ ʟʘʢʨʳʚʘʝʤ, ʥʘ ʩʝʨʦʤ ʥʘʞʠʤʘʝʤ OK. 

ʈʘʩʯʸʪ ʧʦʰʸʣ. 

ʂʦʛʜʘ ʦʥ ʟʘʢʦʥʯʠʪʩʷ, ʧʦʷʚʠʪʩʷ ʦʢʥʦ 

çSolution is done!è. ɿʘʢʨʦʡʪʝ ʵʪʦ ʦʢʥʦ. 

ʈʘʩʯʸʪ ʦʢʦʥʯʝʥ. 
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ʇʨʦʩʤʦʪʨ ʨʝʟʫʣʴʪʘʪʦʚ 

18 

Силовая схема: 

U_M > PlotCtrls  > Symbols  > 

[/ PBC] ʫʩʪʘʥʘʚʣʠʚʘʝʤ ʚ ʧʦʣʦʞʝʥʠʝ 

ñFor  Individual ò 

ʋʙʠʨʘʝʤ ʛʘʣʦʯʢʫ ʩ ñMiscellaneousò 

[ CS]  ʫʩʪʘʥʦʚʠʪʴ ʚ ʧʦʣʦʞʝʥʠʝ ñoff ò 

> OK >  

ɺ ʦʢʥʝ ñApplied Boundary Conditionsò 

  U ʫʩʪʘʥʦʚʠʪʴ ñOff ò 

Rot  ʫʩʪʘʥʦʚʠʪʴ ñOff ò 

  F ʫʩʪʘʥʦʚʠʪʴ ñSymbol +Value ò 

  M ʫʩʪʘʥʦʚʠʪʴ ñSymbol +Value ò 

> OK >  

ɺ ʦʢʥʝ ñReactionsò  

NFOR ʫʩʪʘʥʦʚʠʪʴ ñOff ò 

NMOM ʫʩʪʘʥʦʚʠʪʴ ñOff ò 

RFOR ʫʩʪʘʥʦʚʠʪʴ ñSymbol+Valueò 

RMOM ʫʩʪʘʥʦʚʠʪʴ ñSymbol+Valueò 

> OK >  

ʆʙʥʦʚʣʷʝʤ ʠʟʦʙʨʘʞʝʥʠʝ: 
U_M > Plot  > Elements  

ʇʨʠ ʥʝʦʙʭʦʜʠʤʦʩʪʠ ʢʦʨʨʝʢʪʠʨʫʡʪʝ ʤʘʩʰʪʘʙ ʢʥʦʧʢʘʤʠ  ʠʣʠ . 

ʇʦʣʫʯʘʝʤ ʪʦʪ ʞʝ ʨʝʟʫʣʴʪʘʪ, ʯʪʦ ʠ ʥʘ рис. 1а. ʉʠʥʠʤ ʮʚʝʪʦʤ ʫʢʘʟʘʥ ʚʝʢʪʦʨ ʚʥʝʰʥʝʛʦ 

ʤʦʤʝʥʪʘ, ʬʠʦʣʝʪʦʚʳʤ ï ʚʝʢʪʦʨ ʤʦʤʝʥʪʘ ʨʝʘʢʪʠʚʥʦʛʦ.  
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Составление эпюры внутренней перерезывающей силы: 

M_M > General Postproc  > Element Table  > Define Table  > Add >  

ɺ ʣʝʚʦʤ ʩʧʠʩʢʝ ʚʳʙʨʘʪʴ ñBy sequence  numò 

ʧʦʪʦʤ 

ʚ ʧʨʘʚʦʤ ʚʝʨʭʥʝʤ ʩʧʠʩʢʝ ʚʳʙʨʘʪʴ ñSMISC,ò 

ʧʦʪʦʤ 

ʚ ʧʨʘʚʦʤ ʥʠʞʥʝʤ ʩʧʠʩʢʝ ʢ ʥʘʜʧʠʩʠ ñSMISC,ò 

ʧʨʠʧʠʩʘʪʴ ʩʣʝʚʘ ñ2ò. 

> Apply  >  

ʉʥʦʚʘ:  ñBy sequence  numò, ñSMISC,ò ñ8ò 

> OK 

> Close  

ʕʪʘ ʦʧʝʨʘʮʠʷ ʥʘʟʳʚʘʝʪʩʷ çʟʘʧʦʣʥʝʥʠʝ ʪʘʙʣʠʮʳ ʵʣʝʤʝʥʪʦʚè. ʉʦʟʜʘʸʪʩʷ ʙʘʟʘ ʜʘʥʥʳʭ, 

ʧʦ ʢʦʪʦʨʳʤ ʙʫʜʫʪ ʚʳʚʦʜʠʪʴʩʷ ʨʝʟʫʣʴʪʘʪʳ.  
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Умножение эпюры внутренней перерезывающей силы на “-1”: 

ʇʨʘʚʠʣʘ ʟʥʘʢʦʚ ʫ ʢʦʥʝʯʥʦʵʣʝʤʝʥʪʥʳʭ ʧʨʦʛʨʘʤʤ ʩʚʦʝʦʙʨʘʟʥʳʝ, ʥʝ ʚʩʝʛʜʘ 

ʩʦʚʧʘʜʘʶʱʠʝ ʩ ʧʨʠʥʷʪʳʤʠ ʚ çʉʦʧʨʦʪʠʚʣʝʥʠʠ ʤʘʪʝʨʠʘʣʦʚè. ɺ ʜʘʥʥʦʤ ʩʣʫʯʘʝ ʵʪʦ 

ʚʳʨʘʞʘʝʪʩʷ ʚ ʪʦʤ, ʯʪʦ ʚʳʯʠʩʣʝʥʥʘʷ ʵʧʶʨʘ ʚʥʫʪʨʝʥʥʝʡ ʧʝʨʝʨʝʟʳʚʘʶʱʝʡ ʩʠʣʳ ʠʤʝʝʪ 

ʟʥʘʢʠ ʧʨʦʪʠʚʦʧʦʣʦʞʥʳʝ ʧʨʠʥʷʪʳʤ ʚ ʥʘʰʝʤ ʢʫʨʩʝ. ʀʥʚʝʨʪʠʨʫʝʤ ʵʧʶʨʫ ʚ ʪʘʙʣʠʮʝ 

ʨʝʟʫʣʴʪʘʪʦʚ: 

ʉʪʨʦʯʢʫ SMISC2 ʫʤʥʦʞʘʝʤ ʥʘ -1, ʧʦʣʫʯʘʝʤ ʩʪʨʦʯʢʫ QYI: 

M_M > General Postproc > Element Table > Multiply  

LabR ʧʠʰʝʤ QYI 

FACT1 ʧʠʰʝʤ - 1 

Lab1 ʫʩʪʘʥʘʚʣʠʚʘʝʤ SMIS2 

Lab2 ʫʩʪʘʥʘʚʣʠʚʘʝʤ ïnone- 

> Apply 

ʉʪʨʦʯʢʫ SMISC8 ʫʤʥʦʞʘʝʤ ʥʘ -1, ʧʦʣʫʯʘʝʤ ʩʪʨʦʯʢʫ QYJ: 

M_M > General Postproc > Element Table > Multiply  

LabR ʧʠʰʝʤ QYJ 

FACT1 ʧʠʰʝʤ - 1 

Lab1 ʫʩʪʘʥʘʚʣʠʚʘʝʤ SMIS8 

Lab2 ʫʩʪʘʥʘʚʣʠʚʘʝʤ ïnone- 

> OK 

ʉʤʦʪʨʠʤ ʪʘʙʣʠʮʫ ʨʝʟʫʣʴʪʘʪʦʚ, ʚʠʜʠʤ ʜʚʝ ʥʦʚʳʝ ʩʪʨʦʯʢʠ - QYI ʠ QYJ: 

M_M > General Postproc  > Element Table  > Define Table  

> Close 
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Прорисовка  эпюры внутренней внутренней перерезывающей силы: 

 - ʬʨʦʥʪʘʣʴʥʳʡ ʚʠʜ; 

 - ʘʚʪʦʬʦʨʤʘʪ (ʨʘʟʤʝʨ ʠʟʦʙʨʘʞʝʥʠʷ ʧʦ ʨʘʟʤʝʨʫ ʦʢʥʘ.) 

M_M > General Postproc  > Plot Results  > Conto ur Plot  

> Line Elem Res >  

ʋʩʪʘʥʦʚʠʪʴ LabI  ʚ ʧʦʣʦʞʝʥʠʝ ñQYIò 

ʋʩʪʘʥʦʚʠʪʴ LabJ  ʚ ʧʦʣʦʞʝʥʠʝ ñQYJò 

> OK  

 

 

ʇʦʣʫʯʘʝʤ ʪʦʪ ʞʝ ʨʝʟʫʣʴʪʘʪ, ʯʪʦ ʠ ʥʘ рис. 1б. (ʥʫʣʝʚʘʷ ʵʧʶʨʘ). 
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Составление эпюры внутреннего изгибающего момента: 

M_M > General  Postproc  > Element  Table  > Define  Table  > Add > 

ñBy sequence  numò,  ñSMISC,ò,  ñ6ò > Apply  >  

ñBy sequence  numò, ñSMISC,ò,  ñ12ò > OK > 

> Close  

 

23 

Прорисовка эпюры внутреннего изгибающего момента: 

M_M > General Post proc  > Plot Results  > Contour Plot  

> Line Elem Res > 

LabI  ʫʩʪʘʥʦʚʠʪʴ ñSMIS6ò 

LabJ  ʫʩʪʘʥʦʚʠʪʴ ñ SMIS12ò 

> OK  

ʇʦʣʫʯʘʝʤ ʪʦʪ ʞʝ ʨʝʟʫʣʴʪʘʪ, ʯʪʦ ʠ ʥʘ рис. 1в. (ʪʦʣʴʢʦ ʯʠʩʣʘ, ʚʳʜʝʣʝʥʥʳʝ ʥʘ рис. 1в. 

ʩʠʥʠʤ ʮʚʝʪʦʤ). ʕʧʶʨʘ MIN=1 , MAX =1, ʢʘʢ ʠ ʜʦʣʞʥʦ ʙʳʪʴ ʫ ʧʨʷʤʦʫʛʦʣʴʥʠʢʘ. 
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ʉʦʭʨʘʥʷʝʤ ʧʨʦʜʝʣʘʥʥʫʶ ʨʘʙʦʪʫ: 

U_M > File  > Save as Jobname.db  

ɿʘʢʨʦʡʪʝ ANSYS: 

U_M > File  > Exit > Quit ï No Save! > OK  

 

ʇʦʩʣʝ ʚʳʧʦʣʥʝʥʠʷ ʫʢʘʟʘʥʥʳʭ ʜʝʡʩʪʚʠʡ ʚ ʨʘʙʦʯʝʤ ʢʘʪʘʣʦʛʝ ʦʩʪʘʶʪʩʷ 

ʬʘʡʣʳ ʩ ʨʘʩʰʠʨʝʥʠʷʤʠ ñ.BCSò, ñ.dbò, ñ.ematò, ñ.errò, ñ.esavò, ñ.fullò, ñ.logò, 

ñ.mntrò,  ñ.rstò ʠ ò.statò. 

ʀʥʪʝʨʝʩ ʧʨʝʜʩʪʘʚʣʷʶʪ ñ.dbò (ʬʘʡʣ ʤʦʜʝʣʠ) ʠ ñ.rstò (ʬʘʡʣ ʨʝʟʫʣʴʪʘʪʦʚ 

ʨʘʩʯʸʪʘ), ʦʩʪʘʣʴʥʳʝ ʬʘʡʣʳ ʧʨʦʤʝʞʫʪʦʯʥʳʝ, ʠʭ ʤʦʞʥʦ ʫʜʘʣʠʪʴ. 

 


